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CristalX

[image: badge] [https://mybinder.org/v2/gh/CsatiZoltan/CristalX/master] [image: badge] [https://mybinder.org/v2/gh/CsatiZoltan/CristalX/master?filepath=notebooks%2Fexample_application.ipynb] [image: BCH  compliance] [https://bettercodehub.com/] [image: Documentation Status] [https://cristalx.readthedocs.io/en/latest/?badge=latest] [image: Join the chat at https://gitter.im/Grain-Segmentation/community] [https://gitter.im/CristalX-community/community?utm_source=badge&utm_medium=badge&utm_campaign=pr-badge&utm_content=badge]

Identification of individual grains in microscopic images

CristalX is a Python package that helps in the analysis of polycrystalline microstructures. Its name originates from the French word ‘cristal’, corresponding to the English word ‘crystal’.


Features


	Image segmentation to identify the grains in a microstructure


	Analysis tools for the segmented image


	Explicit geometrical representation of the grains


	Interacting with meshes created on the microstructure


	Mapping fields between a mesh and the grid of DIC measurements


	Simulation tools for the inverse problem arising from a combined numerical-experimental method (in progress …)


	Visualization and data exchange







Getting help


	Read the documentation [https://cristalx.readthedocs.io/].


	Check the existing issues [https://github.com/CsatiZoltan/CristalX/issues]. They may already provide an answer to you question.


	Open a new issue [https://github.com/CsatiZoltan/CristalX/issues/new].







Contributing

Read the docs/source/contributing.md file.




Citing CristalX

We have an article freely available on SoftwareX [https://doi.org/10.1016/j.softx.2021.100669], showing the background and the design of CristalX.

When using CristalX in scientific publications, please cite the following paper:


	Csati, Z.; Witz, J.-F.; Magnier, V.; Bartali, A. E.; Limodin, N. & Najjar, D. CristalX: Facilitating simulations for experimentally obtained grain-based microstructures. SoftwareX, 2021, 14, 100669




BibTeX entry:

@Article{Csati2021,
  author    = {Zoltan Csati and Jean-Fran{\c{c}}ois Witz and Vincent Magnier and Ahmed El Bartali and Nathalie Limodin and Denis Najjar},
  journal   = {{SoftwareX}},
  title     = {{CristalX}: {F}acilitating simulations for experimentally obtained grain-based microstructures},
  year      = {2021},
  month     = jun,
  pages     = {100669},
  volume    = {14},
  doi       = {10.1016/j.softx.2021.100669},
}
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Installation

CristalX is easy to install; you can get started in minutes.


Dependencies

CristalX is a written in pure Python, although it relies on packages that use other languages (mostly C and C++). However, it is not a problem from the user’s perspective as no manual compilation is needed. Those who are interested can see the dependencies in the environment.yml file in the root directory.

Whether you install CristalX by conda or try it online, all but one dependency is installed. In a common workflow, that single missing dependency will not affect you. For details, see …




Try it online

If you just want to get a taste of CristalX, you can try it online without installing anything.

Click here [https://mybinder.org/v2/gh/CsatiZoltan/CristalX/master] to jump to the root directory. Existing Jupyter notebooks are in the notebooks/ directory. You can modify them and create new ones. If you directly want to open the main tutorial, which describes a real-world application, click here [https://mybinder.org/v2/gh/CsatiZoltan/CristalX/master?filepath=notebooks%2Fexample_application.ipynb].




Install it locally

If you want more control (debugging, inspecting variables, etc.) over CristalX or if you wish to contribute to the project, it is recommended to install it on your machine.


Obtain the source

If you are a user of CristalX, the best is to get the latest release:


	download it from GitHub [https://github.com/CsatiZoltan/CristalX/releases]


	or clone it with Git:

git clone https://github.com/CsatiZoltan/CristalX.git
cd CristalX
git checkout v<version_number>





where <version_number> is the version you want to use. E.g. if you want to use version 1.0.1, you need to type git checkout v1.0.1. See the available tags [https://github.com/CsatiZoltan/CristalX/tags], corresponding to the published releases, for the possibilities.

Note that in this case, you will be in a “detached HEAD” state, meaning that the HEAD does not point to a branch but to the specific tag. Any commit you make in this state will not be associated with a branch. Therefore, if you want to develop or contribute to CristalX, check out the master branch (see the next paragraph).





If you want to develop CristalX or simply want to have access to the latest features, you need to fetch the latest state:


	download it from GitHub [https://github.com/CsatiZoltan/CristalX/archive/master.zip]


	or clone it with Git:

git clone https://github.com/CsatiZoltan/CristalX.git












Install with conda

All you need to have is the conda [https://docs.conda.io/en/latest/] package manager. Open a terminal (or a command prompt if you are under Windows) in the root directory and type

conda env create -f environment.yml





CristalX has been installed to a separate environment, so you can safely work inside it. Activate that environment:

conda activate CristalX





Once you have finished working with CristalX, either close the terminal or type

conda deactivate





to return to your default conda environment.

If you want to uninstall CristalX, make sure that the CristalX conda environment is not active and then

conda env remove -n CristalX





When uninstalled, conda env list will not show it.




Install with pip

If you do not have conda or you prefer pip, you can also install CristalX by typing

pip install -r requirements.txt





assuming that you have Python installed. It is highly recommended that you first create a new virtual environment to make sure you do not break your Python installation. However, an important component of CristalX (functions that rely on PythonOCC) will not be installed if you choose pip. The reason for this is that PythonOCC [https://github.com/tpaviot/pythonocc-core] is not (yet) available on PyPI [https://pypi.org/].
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Documentation

The documentation for CristalX is available both locally and online. It is generated by Sphinx [https://www.sphinx-doc.org] and consists of the code documentation and the various guides (including the one you are currently reading). If you want to extend the documentation, please read the corresponding section in the Developer guide.


Local documentation

It resides in the docs/ directory. Open a terminal there and type make html. The output will be written to docs/build/. Open docs/build/html/index.html to land on the home page of the documentation.




Online documentation

For every push event, the documentation is rebuilt by Read the Docs [https://readthedocs.org/]. The latest HTML version is available on https://cristalx.readthedocs.io/en/latest [https://cristalx.readthedocs.io/en/latest/]. Read the Docs is configured [https://github.com/CsatiZoltan/CristalX/blob/master/.readthedocs.yml] to build a PDF and EPUB output as well. All three formats can be downloaded for offline use if you click on the bottom of the left sidebar. For convenience, here are the direct links: HTML [https://cristalx.readthedocs.io/_/downloads/en/latest/htmlzip/], PDF [https://cristalx.readthedocs.io/_/downloads/en/latest/pdf/], EPUB [https://cristalx.readthedocs.io/_/downloads/en/latest/epub/].




Using the HTML documentation

For browsing on a computer, the HTML documentation is the most convenient and feature-rich.

The side-bar on the left provides quick navigation.

Code example boxes have two toggle buttons. Clicking on the prompt button >>> hides the prompt and the output. If you then click on the copy icon next to it, you can copy the contents of the box, making it easy to try the code chunks in your Python environment.

[image: toggle_prompt]

A direct link can be obtained for most sections, including the code documentation, by moving the cursor to the right of the text and then clicking on the chain icon. [image: anchor]

When browsing the API documentation and want to look at the implementation, you can easily access the source code by clicking on the [source] tag. [image: source_code]
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How to use the codes

If you want to get to know the classes and functions, the best is to check the API documentation. Most components are amply documented and contain one or more examples. If you want to see them in action, check out our workflow for a real-world application. If you are curious about the underlying algorithms, consult with the Algorithms section.


Tutorials

The tutorials are available in two forms: Python scripts and Jupyter notebooks.


Python scripts

The scripts are intended to be run in batch mode. They need to be run in a specific order as the subsequent scripts rely on the output of the previous ones. These scripts are useful if you are already a bit familiar with CristalX or if you wish to adapt the scripts to your needs. Indeed, if you intend to extend the package, the safest way is to copy the relevant scripts and modify them. The scripts are named as run_moduleName, where moduleName is the name of the module in the grains/ directory that the script mainly relies on. In some way, run_moduleName acts as a demonstration of what the moduleName module is used for. The scripts are meant to be run as modules, i.e. navigate to the root of the project and type

python -m scripts.moduleName








Jupyter notebooks

Almost the same workflow is available as a single Jupyter notebook, located at the nootebooks/ directory. this allows you to interactively discover CristalX through an example. You can easily rerun parts of the code to see the effects of the parameters, and the rich output is embedded into the same document. If you are a novice Python user or just want to have a taste of CristalX, notebooks are the recommended way to get started.






Undo changes

When you experiment with CristalX, you will probably change parameter values. As the scripts communicate by reading and writing data, the original data that come with CristalX will be overwritten. There are multiple ways to undo the changes.


In Binder

As written in the Installation instructions, you can try CristalX online without the need to install anything on your computer. Then a separate virtual environment is created. Whatever changes you make there, they will not influence your local installation (if you have) or the data on the GitHub repository.




In a local installation

If you downloaded CristalX from GitHub, you can simply replace the new files with the original ones. In case you cloned CristalX with Git, you can easily discard the changes you make.
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A detailed workflow

CristalX contains several modules that facilitate experimental and numerical works on polycrystalline microstructures. The usage of these modules is demonstrated on a complex example.



	Problem formulation

	Initial setup

	Identify grains in a microstructure

	Extending the image domain

	From image to geometry

	Repairing the geometry

	Mesh generation

	Modifying the mesh

	Conclusions
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Problem formulation

Grain-based microstructures occur in nature but also develop during industrial processes. We are interested in how the size and the distribution of grains, and the material they are made up of influence the resistance of train wheels and axles to fatigue loading. The problem requires that


	the individual grains can be distinguished on a microscopic image


	a good quality mesh is generated on the microstructure


	the numerical solution obtained on this mesh can be compared to full-field measurements




The first two steps are discussed here.




Initial setup

First, we switch to the root directory of the project so that the package imports are consistent. Note that the relative path always works because the current directory in case of a Jupyter notebook is always the directory in which the notebook is.


[1]:






import os
os.chdir('../')
main_dir = os.path.abspath(os.curdir)







Let us set the directory that will hold our data.


[2]:






data_dir = os.path.abspath('data')
try:
    os.mkdir(data_dir)
except FileExistsError:
    pass







We now copy the necessary data files that come with CristalX into this freshly created directory.


[3]:






from os.path import join
from shutil import copy
selected_files = ['1.png', '1_cropped.png', 'splinegons.png', '1_mesh_extended.npz']
for file in selected_files:
    copy(join('scripts/data', file), data_dir)







In interactive mode, debug information are displayed. They are not useful for presentation purposes as they pollute the rendered output. Similarly for runtime warnings.


[4]:






import logging
logging.basicConfig(level=logging.ERROR)
import warnings
warnings.simplefilter('ignore')







For the figures to be visible in this notebook, we define a utility function to scale them.


[5]:






import matplotlib.pyplot as plt
def scale_figure(dpi):
    plt.gcf().set_dpi(dpi)










Identify grains in a microstructure

The picture below was taken with a digital camera and shows the central part of a tensile specimen. In this section, we will identify the individual grains in the image.


[6]:






from skimage.io import imshow
imshow(join(data_dir, '1.png'))
scale_figure(150)












[image: _images/example_application_13_0.png]




So that the surrounding region does not interfere with the segmentation, we will work on a cropped region.


[7]:






from skimage.io import imread
import numpy as np
image = join(data_dir, '1_cropped.png')







As you can see, the RGB image is represented as a 3D numpy array.


[8]:






image_as_matrix = imread(image)
type(image_as_matrix), image_as_matrix.shape








[8]:







(numpy.ndarray, (638, 589, 3))






However, you do not explicitly have to deal with this matrix as the Segmentation class will handle it.

The Segmentation class offers a set of methods to perform the consecutive steps of the segmentation workflow. We pass to the constructor the path to the image to be segmented. By default, the resulting images are shown at the end of each step. In batch mode, you probably want to set the interactive_mode optional parameter to False. But in this interactive document, we want to see the outputs.


[9]:






from grains.segmentation import Segmentation
GS = Segmentation(image)












[image: _images/example_application_19_0.png]










Image successfully loaded.






After the image has been loaded and stored in the GS object, we want to remove the noise. Since the interfaces among the grains are important for us, we use median filtering for smoothing as it preserves the contours. The smoothing is governed by the window size. The larger this number, the smoother the processed image is, and the higher the computational cost becomes.


[10]:






filter_window_size = 5
filtered = GS.filter_image(filter_window_size)












[image: _images/example_application_21_0.png]










Median filtering finished.






To improve the segmentation result later, we perform superpixel segmentation as an initial step. During this process, the image is subdivided into superpixels, groups of pixels that belong together based on colour, spatial distance or other properties. On this image, a superpixel algorithm called Quick Shift proved to be the best among the algorithms available in scikit-image.


[11]:






segmented = GS.initial_segmentation(filtered)












[image: _images/example_application_23_0.png]










Quick shift segmentation finished. Number of segments: 421






The result is indeed a segmented (also called labelled) image. Distinct positive integers, called labels, are associated to groups of pixels in the labelled image and each pixel belongs to one and only one such group.


[12]:






segmented








[12]:







array([[  8,   8,   8, ...,   2,   2,   2],
       [  8,   8,   8, ...,   2,   2,   2],
       [  8,   8,   8, ...,   2,   2,   2],
       ...,
       [400, 400, 400, ..., 414, 414, 414],
       [400, 400, 400, ..., 414, 414, 414],
       [400, 400, 400, ..., 414, 414, 414]])






The segmented image has the same size as the original image, but it is not an RGB image any more.


[13]:






segmented.shape, image_as_matrix.shape








[13]:







((638, 589), (638, 589, 3))






We can visualize a labelled image by associating different colours to the different labels.


[14]:






from skimage.color import label2rgb
from numpy.random import random
nlabel = len(np.unique(segmented))
imshow(label2rgb(segmented, colors=random((nlabel, 3))))
scale_figure(150)












[image: _images/example_application_29_0.png]




As the superpixel segmentation in the previous step resulted in an oversegmented image, the region adjacency graph is constructed and used to merge some of the neighbouring superpixels based on their similarity with respect to mean colour. Regions connected by edges with smaller weights than a prescribed threshold are combined. As you can see, the number of supersegments decreases.


[15]:






cluster_merging_threshold = 7
reduced = GS.merge_clusters(segmented, threshold=cluster_merging_threshold)












[image: _images/example_application_31_0.png]










Tiny clusters merged. Number of segments: 177






We need a few more steps before succesfully applying another segmentation technique to obtain the final segmented image. First, we detect the grain boundaries. They are shown superposed on the original image.


[16]:






boundary = GS.find_grain_boundaries(reduced)












[image: _images/example_application_33_0.png]










Grain boundaries found.






The boundary image is a binary image in which the True values indicate the boundaries among the labelled regions.


[17]:






boundary








[17]:







array([[False, False, False, ..., False, False, False],
       [False, False, False, ..., False, False, False],
       [False, False, False, ..., False, False, False],
       ...,
       [False, False, False, ..., False, False, False],
       [False, False, False, ..., False, False, False],
       [False, False, False, ..., False, False, False]])






The we use thinning on the grain boundary to obtain a single-pixel wide skeleton.


[18]:






skeleton = GS.create_skeleton(boundary)












[image: _images/example_application_37_0.png]










Skeleton constructed.






If the automatic segmentation carried out so far is not good enough, the user can manually edit the skeleton as a graph in ImagePy [https://github.com/Image-Py/imagepy]. The combination of the automatic segmentation with human supervision is a powerful way to achieve good results in a relatively short amount of time. Here, we stay with the automatic method.

To recover the segments again, we use watershed segmentation on the skeleton. Had it been directly applied on the original image, the result of the watershed segmentation would have been an oversegmented image due to the noises that act as local minima. The success of the watershed segmentation depends on how well the catchment basins are identified, which are the locations where the flooding starts. The so-called marker-based watershed segmentation methods rely on markers (computed
automatically or given by the user), i.e. the location of the catchment basins, as inputs. In the watershed_segmentation method of the Segmentation class, various transformations are used to obtain a desirable outcome.


[19]:






watershed = GS.watershed_segmentation(skeleton)












[image: _images/example_application_39_0.png]










Watershed segmentation finished. Number of segments: 247






To the left and to the right of the central zone, artificial “grains” appear. This is not a problem, they can either be merged, or left as it is and associate the same material to them.




Extending the image domain

The segmented image corresponds to the recrystallized part of the specimen. When we perform the traction test numerically we need a larger domain, the boundary on which the boundary conditions are applied. The size of this extended domain does not have to match with the physical size of the tensile specimen, but it has to be sufficiently large so that the far-field boundary conditions do no not influence the deformation state in the central region.

As a first step, we extend the domain by padding the corresponding numpy array. Since we want to handle the added domains (grains) on the left and on the right as separate grains, we associate different labels to them. There are about 250 grains in the central region, so choosing labels 500 and 501 ensures that these regions have unique labels.

The extended domain is constructed in such a way that it matches the region of the DIC measurements. This will be useful when comparing the results of the simulation with the experimental data.


[20]:






from grains.simulation import change_domain
extended_image = change_domain(watershed, 0.4395, 0, 0, 0, 500)
extended_image = change_domain(extended_image, 0, 0.5568, 0, 0, 501)
imshow(extended_image)
scale_figure(150)












[image: _images/example_application_43_0.png]







From image to geometry

In this section, we show how to represent the grains as an explicit geometry. See our paper for the motivation.

For grain representation, we can choose between polygon and splinegon approximations. We will base the meshing on the splinegon representation, but the polygons are also shown. The high-level functions polygonize and splinegonize wrap all the important algorithms. You can see from the code below that they share similar function signature. The only difference is that the spline parameters can be provided to the splinegonize function.


[21]:






from grains.cad import polygonize, search_neighbor, splinegonize
polygons = polygonize(extended_image, search_neighbor(2, np.inf), connectivity=1)
splinegons, _ = splinegonize(extended_image, search_neighbor(2, np.inf), connectivity=1, degree_min=3, degree_max=3, continuity='C0', tol=1)







Let us plot the grains. For polygons:


[22]:






from grains.cad import plot_polygons
plot_polygons(list(polygons.values()));
scale_figure(150)












[image: _images/example_application_48_0.png]




Plotting the spline surfaces will bring up a window.


[23]:






from grains.cad import plot_splinegons
from OCC.Display.SimpleGui import init_display
plot_splinegons(list(splinegons.values()), color=(0, 0, 1))













Layer manager created
Layer dimensions: 1024, 768






To allow reading this document statically, here is a screenshot of the window that popped up.


[24]:






fig, ax = plt.subplots(dpi=500)
imshow(join(data_dir, 'splinegons.png'), ax=ax)
ax.set_axis_off()












[image: _images/example_application_52_0.png]




Once we have the spline surfaces, we write them to a STEP file. This allows us to edit the geometry in a CAD program and to generate a mesh for the grains.


[25]:






from grains.cad import regions2step
regions2step(list(splinegons.values()), join(data_dir, 'microstructure.stp'))










Repairing the geometry

For the sample microstructure, one grain was not identified, i.e. it contains a hole. The hole can be filled in by creating a new grain. We have a detailed guide [https://cristalx.readthedocs.io/en/latest/salome.html] on how to do this.




Mesh generation

The same guide linked in the previous section continues with the mesh generation. It happens that we constructed the conforming mesh in Salome, and then exported it to a .med file. Using the med module [https://cristalx.readthedocs.io/en/latest/api.html#module-grains.med] of CristalX, the triangular mesh cells for each grain and the boundary nodes have been extracted. We also have a tutorial on how to process a .med file [https://cristalx.readthedocs.io/en/latest/med.html].




Modifying the mesh

First, we obtain the mesh data that was saved using the med module.


[26]:






mesh_file = join(data_dir, '1_mesh_extended.npz')
with np.load(mesh_file, allow_pickle=True) as mesh:
    nodes = mesh['nodes']
    elements = mesh['elements']
    element_groups = mesh['element_groups']
    node_groups = mesh['node_groups']
# Retrieve groups, which were stored in dictionaries (https://stackoverflow.com/a/40220343/4892892)
element_groups = element_groups.item()
node_groups = node_groups.item()







The array elements contains the label of the nodes in the mesh.


[27]:






elements








[27]:







array([[  603,   604,  4311],
       [  604,    19,   605],
       [  606,    18,  4312],
       ...,
       [13377, 13369, 13374],
       [13372, 13377, 13373],
       [13373, 13370, 13372]])






The array nodes holds the coordinates of each node of the mesh.


[28]:






nodes








[28]:







array([[2.50000000e-01, 2.59000000e+02],
       [8.00000000e+01, 2.59250000e+02],
       [2.31000000e+02, 2.59250000e+02],
       ...,
       [6.28062814e+02, 8.02235833e+02],
       [6.22855688e+02, 7.95968504e+02],
       [6.23756131e+02, 7.89612749e+02]])






The elements are available for each grain. For instance, grain 87 is labelled as Face_87 and it contains the following elements.


[29]:






element_groups['Face_87']








[29]:







array([23231, 23232, 23233, 23234, 23235, 23236, 23237, 23238, 23239,
       23240, 23241, 23242, 23243, 23244, 23245])






We mentioned earlier that some grains are artefacts of the watershed segmentation. In other words, they are outside the recrystallized central region. Therefore, those grains along with the two extensions (that were given the labels 500 and 501) were merged in Salome and a single mesh was constructed on the merged region. That region contains the most elements.


[30]:






len(element_groups['homogeneous'])








[30]:







3718






To be able to prescribe boundary conditions later, the boundary nodes were also exported from Salome.


[31]:






node_groups








[31]:







{'bottom': array([   8,   14,  448,  452,  467,  468,  470,  471,  472,  474,  475,
         477,  478,  479,  480,  481,  482,  495,  496,  497,  498,  499,
         557,  558,  559,  560,  561,  562,  563,  564,  565, 3673, 3674,
        3675, 3676, 3706, 3707, 3708, 3839, 3840, 3841, 3842, 3851, 3852,
        3861, 3862, 3863, 3864, 3865, 3866, 3867, 3874, 3880, 3881, 3882,
        3883, 3884, 3885, 3886, 3887, 3888, 3895, 3896, 3897, 3914, 3915,
        3922, 3923, 3924, 3925, 3926, 3930, 3931, 3932, 3933, 3943, 3944,
        3945, 3951, 3952, 3953, 3954, 3955, 3956, 3957, 3958, 3959, 3960,
        3961, 3962, 3963, 3964], dtype=int32),
 'left': array([  9,  10, 483, 484, 485, 486, 487, 488, 489, 490, 491, 492, 493,
        494], dtype=int32),
 'right': array([ 15,  16, 545, 546, 547, 548, 549, 550, 551, 552, 553, 554, 555,
        556], dtype=int32),
 'top': array([   0,   11,   17,   20,   21,   25,   28,   33,   34,   36,   44,
          45,   46,   52,   61,   63,  541,  542,  543,  544,  594,  595,
         596,  597,  598,  599,  600,  601,  602,  609,  653,  654,  655,
         656,  673,  674,  675,  676,  677,  678,  679,  702,  703,  704,
         705,  706,  707,  724,  725,  749,  750,  751,  759,  760,  761,
         762,  763,  764,  812,  813,  814,  815,  816,  817,  827,  828,
         829,  830,  831,  832,  848,  849,  850,  851,  896,  897,  898,
         920,  921, 1637, 1638, 1639, 1640], dtype=int32)}






Handling all these data individually is tedious. Hence, we created a mesh class that bundles them and defines operations on them. The TriMesh class is an abstraction for a triangular mesh. First, we initialize it with the elements and the nodes that were loaded from the 1_mesh_extended.npz file.


[32]:






from grains.geometry import TriMesh
mesh = TriMesh(nodes, elements)







The TriMesh class has several options to plot the mesh, for now we consider the default plotting.


[33]:






mesh.plot()
scale_figure(150)












[image: _images/example_application_73_0.png]




Then the element and node sets are associated to the mesh object.


[34]:






# Associate the element and node groups to it
for group_name, elements in element_groups.items():
    mesh.create_cell_set(group_name, elements)
for group_name, nodes in node_groups.items():
    mesh.create_vertex_set(group_name, nodes)







Mesh-based discretization methods often presume that the node ordering within an element is counter-clockwise. To make sure this is the case, we explicitly enforce it.


[35]:






mesh.change_vertex_numbering('ccw', inplace=True);







The mesh was created on the geometry, which was constructed based on the image, i.e. in pixel units. For the simulation to be comparable with the experimental data (full-field measurement), the real size of the tensile speciment must be given. In the first image of this notebook, you can observe a ruler. With the help of it, we set the correspondance between the physical unit and the pixel unit: there are 29.55 pixels in 1 mm.


[36]:






mesh.scale(1/29.55, inplace=True);







For convenience, we rotate the specimen so that its axis is parallel to the horizontal tensile loading.


[37]:






from math import pi
mesh.rotate(-pi/2, inplace=True);







Let us check if this is what we wanted.


[38]:






mesh.plot(vertex_legends=True)
scale_figure(150)












[image: _images/example_application_83_0.png]




We are satisfied with the resulting transformations, so let us save them.


[39]:






np.savez_compressed(join(data_dir, '1_mesh_extended_scaled.npz'),
                    nodes=mesh.vertices, elements=mesh.cells,
                    element_groups=mesh.cell_sets, node_groups=mesh.vertex_sets)










Conclusions

We successfully obtained a good quality mesh starting from an image.

In the near future, we will solve an inverse problem to identify characteristic parameters in the constitutive model. This optimization task requires the comparison of the numerical solution obtained on the mesh with the measured field values acquired through digital image correlation (DIC). Some of this work is already available in the dic and simulation modules.

This document is meant to serve as a global overview of what CristalX can be used for. Feel free to play with the parameters to investigate their effects. The functions and classes of CristalX provide many more functionalities. Browse the documentation [https://cristalx.readthedocs.io/en/latest/] to familiarize yourself with the details.



The initially created directory (data/) is now deleted.


[40]:






from shutil import rmtree
try:
    rmtree(data_dir)
except FileNotFoundError:
    pass
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Geometry and mesh processing in Salome

The cad module, as shown in the Algorithms section, allows to approximate a segmented image with planar spline surfaces (splinegons) and those surfaces can be written to a STEP file. Now, we demonstrate on the sample microstructure how to repair the geometry and generate a conforming mesh on the splinegons. All the manipulations are done in Salome 9.4.0.


Geometry


	Import the geometry
To import a STEP file (obtained by writing the splinegons into a STEP file), select the Geometry module and then File -> Import -> STEP.


	Repair the geometry

For the sample microstructure, one grain has not been identified, i.e. it contains a hole. To fill the hole, we perform the following steps (always select the object that was created the last time):


	Repair -> Close Contour and select the (in our sample) two boundary curves of the unidentified grain.


	Repair -> Suppress Holes and select the two boundary curves you selected in the previous step. Salome informs you that a face will be created in place of the hole.


	Repair -> Limit tolerance and set the tolerance to 1e-3.


	Repair -> Sewing and set 1e-2 for the tolerance.






	Extract the grains
We will need the mesh on each grain, therefore, we extract the grain faces by “exploding” the microstructure using New Entity -> Explode. In the dialog box, select the sewn geometry (end result of the geometry repairing workflow above) as Main Object and Face as Sub-shapes Type. Salome properly identifies the 250 sub-shapes, i.e. the grains.


	Fix the “artificial” grains

The sample microstructure describes the central part of a tensile specimen. However, to adhere to the Saint-Venant principle, the loading is exerted further from this central zone. Hence, we created long enough regions in the direction of the prescribed load by attaching two rectangular faces to the central region. These faces are not precise rectangles because the boundary of the microstructure does not consist of straight segments. Nevertheless, from now on, we will use the term rectangle to describe the extended region. To achieve perfect matching between the rectangle and the boundary of the microstructure, one side of the rectangle must contain the same lines as the boundary of the microstructure. The other three sides will be straight line segments.


	We want to extract the boundary lines of the microstructure. To do that, we explode the boundary grains into edges with New Entity -> Explode. The Main Object in the dialog box is a selected boundary grain, and the Sub-shape Type is Edge. Do this with all the boundary grains.


	Create the three sides of the rectangle


	Create the four vertices of the rectangle with New Entry -> Basic -> Point. Two of these points are the extremities of the microstructure, the other two are given such that


	the rectangle’s three sides become parallel to the coordinate axes (so that boundary conditions are easily prescribed)


	the length of the longer side of the rectangle is long enough compared to the microstructure (we applied a ratio of 5)






	Connect these vertices with three lines, which forms the three sides of the rectangle: New Entity -> Build -> Edge.






	Create the rectangle by connecting the three line segments constructed in the previous step with the boundary lines of the fourth side, obtained by exploding the boundary grains: New Entity -> Build -> Wire.


	Delete the original “artificial” grain as it will be replaced by the new one.


	Create the surface enclosed by the rectangle: New Entity -> Build -> Face, and select the wire created before. Perform steps 1-5 for the other rectangle (on the other side of the microstructure) as well.


	In order to create a conforming mesh on the whole domain (i.e. on the microstructure and on the two rectangles), we need to create a compound surface: New Entity -> Build -> Compound and select the grains plus the two rectangles.


	It is not enough to create the mesh, we also need to know which elements belong to which grains. To allow this, we explode the compound surface: select the compound object created in the previous step as the Main Object in New Entity -> Explode. The Sub-shape Type is Face, as before.








The geometry is now impeccable, let us start meshing.




Mesh

Select the Mesh module.


	Create the mesh


	Choose Mesh -> Create Mesh from the menu. The geometry on which the mesh will be created is the compound surface.


	The mesh type in this study is Triangular and the algorithm is NETGEN 1D-2D. Choose NETGEN 2D Parameters as a hypothesis and experiment with the settings to suit your needs. Accept the changes.


	Choose Mesh -> Compute to generate the mesh with the chosen settings.




If you want to alter the mesh, change the hypothesis and compute the new mesh.



	Obtain the sub-meshes for the grains

The segmented image contains regions that are not part of the recrystallized region, but they belong to the homogeneous region. We want to handle them in the same way as the two artificial grains. We do not need to merge the surfaces, just put them in the same element group. Therefore, we create


	a common element group for the elements lying in the homogeneous region


	one element group for each grain in the heterogeneous (recrystallized) region




using Mesh -> Create Groups from Geometry and selecting all the 250 faces of the geometry. To form a single group for the heterogeneous region, merge the corresponding element groups in Mesh -> Union Groups. Once done, delete the groups that were used in forming the union.



	We will explicitly need to prescribe boundary conditions on the left and right sides of the rectangular domain. For this, the nodes on those sides are collected with Mesh -> Create Group and set the Elements Type to Node. Select the nodes on the left edge and give the node set a name. Repeat it for the nodes on the right.


	Export the mesh
Click on File -> Export -> MED file. The sub-meshes (element groups, node groups) are also exported.




The mesh is ready for further processing. We have another guide that discusses how to handle the MED file from within Python.
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Processing a .med file

After exporting the mesh from Salome to a MED file, we may want to perform certain operations on it. The MEDCoupling [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/index.html] tool of Salome provides C++ and Python APIs for this purpose. However, that requires the user to


	have Salome installed as those APIs are available from the Salome kernel


	get to know the API




Moreover, it can happen that some mesh processing functionalities they may want to use does not exist. Since meshes consisting of cells of the same type (e.g. triangles) can be represented as homogeneous and contiguous arrays, converting the mesh from MED to numpy arrays seems a reasonable choice. This is what our med module does: it provides a thin wrapper around MEDCoupling to extract the mesh and the defined groups (cell and vertex groups) from the MED file and convert them to numpy arrays. This way, the user who deals with numerical modelling can implement their mesh processing algorithms based on numpy arrays, which is fast and straightforward. Furthermore, the person who performs the CAD operations and has Salome installed, can use our med module to export the mesh to numpy arrays so that the numerical analyst can directly work on it without having to have Salome installed and without any knowledge on the MEDCoupling API.

If you want to know more about the implementation details, read the documentation for the med module.


Using the module

To use our med module, access to the MEDLoader module from Salome is required. In the following, we assume that Salome has been installed and added to the path, so the command salome is available. If you


	want to use the Python REPL:

$ salome shell -- python
Python 3.6.5 (default, Dec 16 2019, 16:42:15) 
[GCC 7.3.0] on linux
Type "help", "copyright", "credits" or "license" for more information.





Now, you have access to the MEDCoupling Python API. E.g.

>>> from MEDLoader import MEDFileData







	want to use the PyCharm IDE

$ salome shell "path_to_PyCharm/bin/pycharm.sh"





This will start PyCharm. In the IDE (PyCharm in this example), set the interpreter to that of Salome’s Python. For me, it is located at BINARIES-UB18.04/Python/bin/python3, where UB18.04 refers to the fact that I download [https://www.salome-platform.org/downloads/current-version]ed a pre-compiled Salome binaries for Ubuntu 18.04.





To learn more about the salome command, read the manual [https://docs.salome-platform.org/latest/tui/KERNEL/salome_command.html].
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Algorithms

The goal of this document is to provide more low-level algorithmic details than what is given in our paper. In fact, the material presented here is complimentary to the paper. The paper concentrates on the intuition behind the methods and shows the high-level structure, also citing the relevant literature.


From image to geometry

It is recommended to read Section 2.3 of the paper first and then this section.

The algorithm to construct a geometrical representation out of a segmented image is complex. To reduce the complexity, we created composable parts. We start with some notions below. Then the main steps of the algorithm is discussed in the upcoming subsections.

Grains can have different representations. When represented as an image (input in our algorithm), it is a set of pixels labelled with the same positive integer. A grain can be given different geometrical representations. It can be the assembly of primitive shapes, usually triangles. One can also describe a grain by its boundary. For example, piecewise linear boundary segments lead to a polygon, connecting spline curves lead to a splinegon. A grain can also be represented as a cycle of a graph.

We make distinction between topological and geometrical data. Topological data includes connectivity, neighbourhood and membership information. Coordinates of points are examples for geometrical data. Separating these two terms allows us to build abstractions in the code, making it understandable and extensible.


Skeleton of the image

Based on the segmented/labelled image, skan [https://github.com/jni/skan] builds the skeleton network, as demonstrated on a sample image below. The different pixel colors represent different labels.

[image: skeleton_skan]

As a preprocessing step, we create an additional labelled region that surrounds the original labelled image. The reason is that this way, skan will create branches along the boundary of the original image, which will close the boundary grains. It also simplifies the algorithms we will use later because the boundary interfaces can be handled in the same way as the internal ones: every interface separates exactly two grains.




Which branches form a grain?

The question arises: given the branches, how to reconstruct the grains? First, let us try a graph theoretic approach. In the example below, we want to identify the three grains denoted by roman numerals. The network of branches can be represented as a graph, in which the vertices are the end points and the edges correspond to the branches.

[image: graph_representation]

Adequately selected cycles in this graph would give the grains. However, as discussed in the paper, determining the grains based on the graph exclusively would be very challenging because of the following characteristics.


	For general microstructures, the graph contains multiple edges (see the example above), which rules out many graph processing methods.


	Finding all the elementary cycles in the graph is too costly for graphs coming from realistic microstructures. Even if we found all the cycles, we would need a criterion to choose which ones correspond to grains. E.g. the cycle \( \bar{6}-\bar{2}-\bar{3}-\bar{5} \) does not encompass a single grain but the union of two grains.


	Another technique to find the correct cycles would be the minimum cycle basis. However, this basis is not unique so there is no guarantee that we find the adequate cycles.




The solution is to use both topological and geometrical information. The skeleton is superimposed on the labelled image (from which it was constructed by skan) and the labels around a given skeleton node or end point is detected. Staying with the example in the first subsection, the scheme is shown below.

[image: geom_and_topo]

In the following, we describe an algorithm to find out which two grains are incident to a branch (remember that always two grains neighbor a branch).


Algorithm

The neighbor search around every node of a branch is performed and the two most common labels are chosen. Since in the image representation the grain is a set of pixels having the same label, the selected two labels give the neighboring two grains to a branch.




Neighbor definitions

As described in the paper, certain scenarios necessitate to consider various neighborhood definitions. For those definitions, see the documentation of the grains.utils.neighborhood function.

Going back to the first configuration in the beginning of this section, the algorithm gives the following branch-grain connectivities.


\[\begin{split}\bar{1} &: [\mathrm{I}] \\
\bar{2} &: [\mathrm{II}] \\
\bar{3} &: [\mathrm{I}, \mathrm{II}] \\
\bar{4} &: [\mathrm{III}, \mathrm{II}] \\
\bar{5} &: [\mathrm{I}, \mathrm{III}] \\
\bar{6} &: [\mathrm{II}, \mathrm{I}] \\\end{split}\]

Inverting this relationship gives the grain-branch connectivities:


\[\begin{split}\mathrm{I} &: [\bar{1}, \bar{3}, \bar{5}, \bar{6}] \\
\mathrm{II} &: [\bar{2}, \bar{3}, \bar{6}, \bar{4}] \\
\mathrm{III} &: [\bar{5}, \bar{4}]\end{split}\]

The grain-branch connectivities are an intermediate representation (topological-geometrical). It is independent of how we geometrically represent a grain later.






Grains as oriented planar surfaces

The previous part of the reconstruction algorithm determined which branches bound a grain. In order to obtain a surface representation of a grain, the boundary must be oriented and hence the branches must be connected in the appropriate order. The following figure demonstrates for grain \( \mathrm{II} \) the working of a brute-force algorithm.

[image: orient_boundary]

The branches are interlaced based on their common junctions. The arrows show which branches follow in order. Note that the default orientation of branches \( \bar{3} \) and \( \bar{4} \) needs to be swapped.

Finally, we arrive at a fully geometrical description because each grain is now given by a series of points (nodes and end points) along its boundary.




Geometrical representations of grains

Now that we have a list of points, we can build two geometrical representations of a grain. In the polygon representation, the list of points are the consecutive vertices of the polygon. Their coordinates are stacked, the first vertex being repeated to “close” the polygon. In the spline representation, the list of points on each branch act as a knots of a B-spline. Once the bounding splines have been constructed, the planar spline surface (splinegon) is spanned by those bounding splines.

[image: geometrical_representations]
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Program design

CristalX is not a black-box library such as BLAS, neither is a GUI-based application intended for end-users. It is rather an easy-to-use and extensible set of Python codes that provide the basic functionalities that scientists can extend based on their needs. The following ideas were kept in mind while writing and maintaining CristalX.


	Driven by actual needs




Only implement features that are currently used. Adding extra features requires more testing, possibly more dependencies and therefore code bloat, and increases the cognitive load of the user. Instead, the emphasis is on creating a stable minimum core library that can be easily extended according to users’ demands. Consequently, application code is separated from the core modules.


	Build on well-established packages




We rely on the scientific Python stack: NumPy for array manipulations, SciPy for interpolation and some other computations, Matplotlib for visualization and scikit-image for image processing. This ensures interoperability with other scientific codes and that our software is hopefully bug-free.


	Minimize the dependencies




Rapid prototyping is essential in scientific code development and Python is an excellent choice to satisfy this requirement. At the same time, relying on fast libraries ensures that the computations are reasonably fast. The libraries mentioned in the previous point are easy to install, often already pre-installed in certain Python distributions.


	High-quality documentation




Future contributors will benefit from the rich documentation. Python doctests are extensively used, serving both as test cases and as examples of usage. The docstrings conform to the numpydoc style guide.


	We strive for decoupling the modules




Although part of the grains package, if the modules are independent, they can be reused in other projects too just by copy-pasting the required functions.


	Do not overuse classes




In the prototyping phase, prefer using free functions to methods. As an idea evolves, you will naturally find data and algorithms that belong together, and can refactor free functions into member functions of a class.


	Do not use deep hierarchies




Initially, stay away from excessive nesting to avoid fragmenting the code base. If the project grows big, you can still refactor the code by introducing deeper hierarchies. Deep nesting causes unnecessary cognitive load and it also makes the code more verbose at the caller’s site. Compare

import package1.package2.module





with

import package.module






	Gradually refactor code




As more and more features are added to the project, we will often find that similar tasks emerge in different contexts. It is a good time to think about how they can be generalized and to reconsider your model. This way, you will come up with utility functions best put into utils.py.


	Start writing code only after careful thinking




It is no point in writing code before you completely understand your problem domain you want to model. It is more efficient to build abstractions in your head or on paper, then to split it into modular chunks, and only after that start coding.


	Write the documentation before the code




If you document the function parameters and the return values in advance, as well as construct a doctest, you are enforced to think about the problem deeply and to create a good interface. Moreover, it guarantees that the documentation is not missing (what you would anyway have to write at some point, so why not at the beginning?).


	Give doctest-compatible examples




You hit two birds with the same stone: provide an example for the user and get some confidence that your code works as intended (at least for the particular example). As mentioned in the previous point, write them before the actual code implementation. Doctests do not replace careful testing.


	Keep the documentation as part of your code




The problem with wiki pages is that they are version controlled in a different Git repository. It makes it longer to change a hosting service (e.g. moving from GitHub to GitLab), you need to maintain two repositories, cannot change the documentation and the code in the same commit, and you have to rely on the rendering capabilities of the hosting service (e.g. GitHub cannot render math). It is therefore better to keep the documentation as part of your project in a dedicated directory (docs/ in our case), use a documentation generator (Sphinx in our case) and host it online (on Read the Docs in our case).





          

      

    
        [image: Fork me on GitHub]
    
  
    
    Coding conventions
    

    

    

    

    

    

    

    

    

    

    

    

    

    

    
 
  

    

      
          
            
  


Coding conventions
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Documentation

Writing documentation is necessary when you contribute to this project, either by writing code or by changing/extending the external documents. In this section, we give tips how you can write them. This is an opinionated topic and it lays down how it is currently done. Feel free to suggest new ideas.

Whenever you write the documentation, first test it locally before pushing changes: Read the Docs spends about 1000 seconds to build the documentation.

It took me a long time to experiment with the Sphinx settings that provide the output what you can see in the rendered documentation. Some notes concerning these efforts can be found in the Notes section. Another way to learn about Sphinx documentation is by reading the source of the existing documentation. On each page of the HTML documentation, the header contains a View page source hyperlink.


Code documentation

As shown in the figure, codes are written either as Python files or as Jupyter notebooks. With the proper extensions (see the docs/source/conf.py file), both of them are automatically included in the documentation by Sphinx. In what follows, we concentrate on documenting Python files.

The docstings are written in RST, following the numpydoc [https://numpydoc.readthedocs.io/en/latest/format.html] style, using the Napoleon [https://www.sphinx-doc.org/en/master/usage/extensions/napoleon.html] Sphinx extension.

Provide doctests [https://docs.python.org/3/library/doctest.html] to demonstrate the use of the function you write and to provide minimal testing.

The line length is 100 characters, as defined in the /.editorconfig file.




External documentation

The external documentation is written in reStructuredText (RST) and in Markdown. Sphinx, by default, uses RST, extending it with more capabilities. However, recommonmark [https://github.com/readthedocs/recommonmark] can parse Markdown files and automatically convert them to RST at documentation build time. This is a great help as more people are used to the simple Markdown than to the more complex (and more capable) RST. Actually, the current document you read was also written in Markdown. Of course, it is perfectly fine if you write the documentation exclusively in RST.

Currently, the structure of the documentation is written in RST, and most of the external documentation in Markdown.







          

      

    
        [image: Fork me on GitHub]
    
  
    
    Development
    

    

    

    

    

    

    

    

    

    

    

    

    

    

    
 
  

    

      
          
            
  


Development

Intro …


General workflow

The development workflow can be followed in the following figure.

[image: Alt text]


	You write the Python source codes (.py) and the Jupyter notebooks (.ipynb) on your local machine. If you want, you can create the documentation [https://numpy.org/doc/stable/docs/index.html#documentation] locally using Sphinx.


	When a logical unit has been finished, you commit the changes with git push. This will upload the new version of the modified files to a remote repository (currently GitHub). If you edit files in the remote repository and you want those changes to be present in your local copy, you can use git pull. For more details on Git, read the manual [https://git-scm.com/docs/git-pull].


	Several commit hooks are attached to the remote repository. When they detect a change, certain actions are activated. One the one hand, the online version of the documentation, hosted on Read the Docs [https://cristalx.readthedocs.io/] will be updated. On the other hand, static analyzers will reanalyze the new version of the code. Some of them may create a pull request based on their recommendations.







Profiling

I use Pyinstrument [https://github.com/joerick/pyinstrument] for profiling the code. It comes with the CristalX installation.

Otherwise, you can install it with pip install pyinstrument or by conda after the conda-forge channel has been activated [https://conda-forge.org/docs/user/introduction.html#how-can-i-install-packages-from-conda-forge].

conda install -c conda-forge pyinstrument





As Pyinstrument has no dependencies [https://github.com/joerick/pyinstrument/issues/102], you can safely install it to your current environment. If you do not want to take a risk, create a new environment. With conda, you can do e.g.

conda create -n pyinstrument python=3.7 scipy matplotlib
conda activate pyinstrument
conda install -c conda-forge pyinstrument





The profiling module provides a wrapper around Pyinstrument. Put the code you want to profile in the profile context manager, e.g.

>>> import random
>>> from grains.profiling import profile
>>> with profile('html') as p:
...    for _ in range(1000000):
...        rand_num = random.uniform(1, 2.2)





For more details see the API reference.
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Contributing

CristalX is an open-source project that welcomes contributions of any kind.


What can you help in?

The major fields in which you can help are the following (in increasing complexity).


Use cases

If you use CristalX in your project, let us know. Parts of your code, if they are general enough to be incorporated, could be included in CristalX. Make contact with us by opening an issue.




Documentation

If the documentation of some functions


	is missing


	is incomprehensible


	does not contain examples


	is not rendered properly




or if the code examples break, open a pull request. Similarly, open a pull request if the guides


	contain typos


	are incomprehensible







Code


	You can report bugs by opening an issue.


	If you want to help but do not know where to start, consider the currently open issues [https://github.com/CsatiZoltan/CristalX/issues?q=is%3Aopen+is%3Aissue], especially the ones with the help wanted [https://github.com/CsatiZoltan/CristalX/issues?q=is%3Aopen+is%3Aissue+label%3A%22help+wanted%22] label.


	You can implement new features. First of all, contact us if you plan to work on a non-trivial feature. This will save work for you. Use the fork & PR workflow.









How to contribute

First, create a GitHub account. There are two ways to contribute.


Open an issue

To open a new issue [https://github.com/CsatiZoltan/CristalX/issues/new], click on the green button on the Issues page.

[image: new_issue]




Fork & pull request

At the moment, there are no code formatting guidelines, the best is to follow the formatting of the existing code.


	Fork the GitHub [https://github.com/CsatiZoltan/CristalX] repository by clicking on the Fork button at the top right corner.

[image: fork]



	Install CristalX locally by cloning your fork (git clone).


	Create a new branch.

Do not work on the default (master) branch but create a new feature branch, e.g.

git checkout -b new_feature







	Make your changes.

Add or modify files and regularly commit your changes to your local clone with meaningful commit messages [https://chris.beams.io/posts/git-commit/] (git commit). Do not forget to test your code: if you do not provide unit tests, at least write doctests.



	Push your changes to your remote fork on GitHub (git push).


	Visit your forked repository on GitHub and click on the Pull request button. See the GitHub documentation [https://docs.github.com/en/free-pro-team@latest/github/collaborating-with-issues-and-pull-requests/creating-a-pull-request-from-a-fork] for details.

[image: PR]



	Keep your fork up to date

While you work on your forked repository, changes may be committed to the original (called upstream) repository. To make sure you keep your fork up to date with the upstream repository, follow the instructions in the GitHub documentation [https://docs.github.com/en/free-pro-team@latest/github/collaborating-with-issues-and-pull-requests/syncing-a-fork].





This was a basic overview, for more details check out the following documents:


	https://gist.github.com/Chaser324/ce0505fbed06b947d962


	https://github.com/susam/gitpr
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Versioning

The versioning of CristalX starts with 1.0.0 and it somewhat follows the rules of Semantic Versioning 2.0.0 [https://semver.org/], with the syntax MAJOR.MINOR.PATCH, where MAJOR introduces significant changes, MINOR comes with smaller changes, and PATCH provides a fixture or a tiny improvement either in the code or in the documentation.


Why not SemVer?

Semantic Versioning (SemVer [https://semver.org/]) is a widely used versioning scheme, applicable for public APIs. Its purpose is to be rigorous on how to indicate when a bug fix, new features or incompatible changes in the public API are introduced. There is an excellent discussion about it here [https://gist.github.com/jashkenas/cbd2b088e20279ae2c8e] and a detailed guide here [https://www.jering.tech/articles/semantic-versioning-in-practice]. Many criticize it for not being indicative about the rate of important changes. E.g. 1.8.5 –> 1.9.0 may include dozens of relevant improvements, while 1.9.5 –> 2.0.0 may merely be a simple clean-up that changes the public API. However, SemVer was never meant to be used for software version numbers [https://gist.github.com/jashkenas/cbd2b088e20279ae2c8e#gistcomment-3448638].

CristalX is not a library, but a collection of tools that operate at a high level. Most of its functions are exposed to the user, except the ones marked with a leading underscore or two leading underscores. However, the public API would be a subset of these functions: e.g. the functions of the utils module are exposed but they are mostly intended to be used by other modules, not by the user. As CristalX is not a library but rather a tool for rapid prototyping, semantic versioning would not make much sense.




Why not CalVer?

Calendar Versioning (CalVer [https://calver.org/]) is an alternative to SemVer. CristalX may not come with regular changes in the future or it will get updates at irregular intervals. We do not want to give the impression that relevant changes are introduced linearly in time. Moreover, the changelog and the time stamp in the git commits clearly show when new releases are published.




Our versioning

As there is no unconditionally best versioning system, we came up with our own, which seems to fit well for research code like CristalX. The starting point is SemVer with some differences. Our versioning is intended for humans. The MAJOR version in increased only for substantially new features. This is, of course, subjective but we want to avoid large MAJOR version numbers as e.g. in Firefox. The guideline to follow is that the novelty of a feature makes the MAJOR version increase, not the number of additions. Here are some examples. Assume that we are at 1.2.3. We fixed a set of related bugs in the code: 1.2.3 –> 1.2.4. Then we implemented several functionalities to speed up the code: 1.2.4 –> 1.3.0. A new module was created and several others were modified that allowed us to carry out groundbreaking research: 1.3.0 –> 2.0.0. An existing algorithm was improved to handle the corner cases: 2.0.0 –> 2.1.0.

Similarly to SemVer, when one of the digits increases, the ones right to it are set to zero (e.g. 1.0.1 –> 1.0.2,  1.0.3 –> 1.1.0,  1.8.6 –> 2.0.0).

We try to keep backward compatibility. Insignificant changes are postponed, and are included as part of a MINOR release. If you often feel the need to introduce changes to the function signatures, rather add new functions and give deprecation notices than remove or modify existing ones. This does not lead to code bloat in the long run because deprecated syntax is removed from time to time. To mark a function, a method or a class as deprecated, import the deprecated function from the deprecation package and follow its syntax [https://deprecation.readthedocs.io/en/latest/index.html#deprecation.deprecated].

The master branch of the Git repository contains the latest developments since the last published release. These unreleased modifications are allowed to contain incompatibilities (changes in the function signatures, etc.) compared to the latest release. This flexibility is essential for rapid prototyping in research codes like CristalX. However, these possible incompatibilities must be fixed for the next release, see the previous paragraph.


Connection with the Git workflow

The version numbers are reflected in the tag names. Your normal Git workflow stays the same: commit modifications and push them to the remote repository. When you want to mark a commit yet to be included in a certain version, type

git tag -m "Concise message" v<version_number>





where <version_number> has the form MAJOR.MINOR.PATCH. Note that it is preceded by the v letter, conventionally used for tags. As an example [https://github.com/CsatiZoltan/CristalX/tags]:

git tag -m "Initial release." v1.0.0





Keep the tag message short: the detailed changes since the previous version are collected in the changelog.

The tag is pushed by

git push --tags





Whenever you publish a tag, and hence update the changelog, also create a release [https://github.com/CsatiZoltan/CristalX/releases] for that tag on GitHub. Copy the changes the new version brings from the changelog to the description of the release. In this regard, we follow the way of JabRef [https://github.com/JabRef/jabref/releases]. The zipped size of CristalX is quite small, so size constraint will not be a problem on GitHub [https://docs.github.com/en/free-pro-team@latest/github/managing-large-files/distributing-large-binaries].
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Segmentation

This module contains the Segmentation class, responsible for the image
segmentation of grain-based materials (rocks, metals, etc.)


Classes







	Segmentation

	Segmentation of grain-based microstructures







	
class grains.segmentation.Segmentation(image_location, save_location=None, interactive_mode=True)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Segmentation of grain-based microstructures


	
original_image

	Matrix representing the initial, unprocessed image.


	Type

	ndarray










	
save_location

	Directory where the processed images are saved


	Type

	str [https://docs.python.org/3/library/stdtypes.html#str]










	
create_skeleton(boundary_image)

	Use thinning on the grain boundary image to obtain a single-pixel wide skeleton.


	Parameters

	boundary_image (bool ndarray) – A binary image containing the objects to be skeletonized.



	Returns

	skeleton (bool ndarray) – Thinned image.










	
filter_image(window_size, image_matrix=None)

	Median filtering on an image.
The median filter is useful in our case as it preserves the important
borders (i.e. the grain boundaries).


	Parameters

	
	window_size (int) – Size of the sampling window.


	image_matrix (3D ndarray with size 3 in the third dimension, optional) – Input image to be filtered. If not given, the original image is used.






	Returns

	filtered_image (3D ndarray with size 3 in the third dimension) – Filtered image, output of the median filter algorithm.










	
find_grain_boundaries(segmented_image)

	Find the grain boundaries.


	Parameters

	segmented_image (ndarray) – Label image, output of a segmentation.



	Returns

	boundary (bool ndarray) – A bool ndarray, where True represents a boundary pixel.










	
initial_segmentation(*args)

	Perform the quick shift superpixel segmentation on an image.
The quick shift algorithm is invoked with its default parameters.


	Parameters

	*args (3D numpy array with size 3 in the third dimension) – Input image to be segmented. If not given, the original image is used.



	Returns

	segment_mask (ndarray) – Label image, output of the quick shift algorithm.










	
merge_clusters(segmented_image, threshold=5)

	Merge tiny superpixel clusters.
Superpixel segmentations result in oversegmented images. Based on graph
theoretic tools, similar clusters are merged.


	Parameters

	
	segmented_image (ndarray) – Label image, output of a segmentation.


	threshold (float, optional) – Regions connected by edges with smaller weights are combined.






	Returns

	merged_superpixels (ndarray) – The new labelled array.










	
save_array(filename, array)

	Save an image as a numpy array.
The array is saved in the standard numpy format, into the directory determined by the
save_location attribute.


	Parameters

	
	filename (str) – The array is saved under this name, with extension .npy


	array (ndarray) – An image represented as a numpy array.













	
save_image(filename, array, is_label_image=False)

	Save an image as a numpy array.
The array is saved in the standard numpy format, into the directory determined by the
save_location attribute.


	Parameters

	
	filename (str) – The array is saved under this name, with extension .npy


	array (ndarray) – An image represented as a numpy array.


	is_label_image (bool) – True if the array represents a labeled image.













	
watershed_segmentation(skeleton)

	Watershed segmentation of a granular microstructure.
Uses the watershed transform to label non-overlapping grains in a cellular
microstructure given by the grain boundaries.


	Parameters

	skeleton (bool ndarray) – A binary image, the skeletonized grain boundaries.



	Returns

	segmented (ndarray) – Label image, output of the watershed segmentation.


















Gala

A trimmed version of the Gala project (https://github.com/janelia-flyem/gala)
with some additions (new function, added documentation for the existing ones).
Gala is licensed by the Janelia Farm License:
http://janelia-flyem.github.io/janelia_farm_license.html

Copyright 2012 HHMI. All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list
of conditions and the following disclaimer.  Redistributions in binary form must
reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of HHMI nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


Functions







	imextendedmin(image, h[, connectivity])

	Extended-minima transform.



	hminima(a, thresh)

	Suppress all minima that are shallower than thresh.



	imhmin(a, thresh)

	Suppress all minima that are shallower than thresh.



	morphological_reconstruction(marker, mask[, …])

	Perform morphological reconstruction of the marker into the mask.



	regional_minima(a[, connectivity])

	Find the regional minima in an ndarray.



	complement(a)

	







	
grains.gala_light.complement(a)

	




	
grains.gala_light.hminima(a, thresh)

	Suppress all minima that are shallower than thresh.


	Parameters

	
	a (array) – The input array on which to perform hminima.


	thresh (float) – Any local minima shallower than this will be flattened.






	Returns

	out (array) – A copy of the input array with shallow minima suppressed.










	
grains.gala_light.imextendedmin(image, h, connectivity=1)

	Extended-minima transform.
The extended minima transform is the regional minima of the h-minima transform.
The implementation follows the MATLAB function under the same name.


	Parameters

	
	image (ndarray) – The input array on which to perform imextendedmin.


	h (float) – Any local minima shallower than this will be flattened.


	connectivity (int, optional) – Determines which elements are considered as neighbors of the central
element. Elements up to a squared distance of connectivity from
the center are considered neighbors. If connectivity=1, no diagonal
elements are neighbors.






	Returns

	bool ndarray – True at places of the extended minima.










	
grains.gala_light.imhmin(a, thresh)

	Suppress all minima that are shallower than thresh.


	Parameters

	
	a (array) – The input array on which to perform hminima.


	thresh (float) – Any local minima shallower than this will be flattened.






	Returns

	out (array) – A copy of the input array with shallow minima suppressed.










	
grains.gala_light.morphological_reconstruction(marker, mask, connectivity=1)

	Perform morphological reconstruction of the marker into the mask.

See the Matlab image processing toolbox documentation for details:
http://www.mathworks.com/help/toolbox/images/f18-16264.html






	
grains.gala_light.regional_minima(a, connectivity=1)

	Find the regional minima in an ndarray.
As written in the MATLAB documentation of the imregionalmin function:
“Regional minima are connected components of pixels with a constant
intensity value, surrounded by pixels with a higher value.”










Analysis

This module contains the Analysis class, responsible for the analysis of
segmented grain-based microstructures.

All the examples assume that the modules numpy and matplotlib.pyplot were imported as np
and plt, respectively.


Classes







	Analysis

	Analysis of grain assemblies.









Functions







	feret_diameter(prop)

	Determines the maximum Feret diameter.



	plot_prop(prop[, pixel_per_unit, show_axis])

	Plots relevant region properties into a single figure.



	plot_grain_characteristic(characteristic, …)

	Plots the distribution of a given grain characteristic.



	show_label_image(label_image[, alpha])

	Displays a labeled image.



	label_image_skeleton(label_image)

	Skeleton of a labeled image.



	thicken_skeleton(skeleton, thickness)

	Thickens a skeleton by morphological dilation.



	label_image_apply_mask(label_image, mask, value)

	Changes parts of a labeled image to a given value.







	
class grains.analysis.Analysis(label_image, interactive_mode=False)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Analysis of grain assemblies.


	
original_image

	Matrix representing the initial, unprocessed image.


	Type

	ndarray










	
save_location

	Directory where the processed images are saved


	Type

	str [https://docs.python.org/3/library/stdtypes.html#str]










	
compute_properties()

	Determines relevant properties of the grains.
The area of each grain is determined in the units previously given in
the set_scale method.


	Parameters

	
	window_size (int) – Size of the sampling window.


	image_matrix (3D ndarray with size 3 in the third dimension, optional) – Input image to be filtered. If not given, the original image is used.






	Returns

	filtered_image (3D ndarray with size 3 in the third dimension) – Filtered image, output of the median filter algorithm.










	
set_scale(pixel_per_unit=1)

	Defines a scale for performing computations in that unit.
Image measures (area, diameter, etc.) are performed on a matrix
corresponding to a label image. Therefore, the result of all the
computations are obtained in pixel units. It is often of interest to
access the results in physical units (mm, cm, inch, etc.). Manually
converting pixels, pixel squares, etc. to pyhsical units, physical unit
sqaures, etc. are tedious and error prone. Once the conversion between
a pixel and a physical unit is given, all the subsequent calculations
are performed in the desired physical unit.


	Parameters

	pixel_per_unit (float or int or scalar ndarray, optional) – Number of pixels contained in a certain unit. The default is 1, in
which case all measurements are performed in pixel units.



	Returns

	None.










	
show_grains(grain_property=None)

	Display the grains, optionally with a property superposed.


	Parameters

	
	grain_property ({None, ‘area’, ‘centroid’, ‘coordinate’,) –               ‘equivalent_diameter’, ‘feret_diameter’, ‘label’}
	optional





If not None, the selected property is shown on the grain as text.



	Returns

	None.










	
show_properties(gui=False)

	Displays previously computed properties of the grains


	Parameters

	gui (bool, optional) – If true, the grain properties are shown in a GUI. If false, they
are printed to stdout. The default is False.
The GUI requires the dfgui modul, which can be obtained from
https://github.com/bluenote10/PandasDataFrameGUI



	Returns

	None.














	
grains.analysis.feret_diameter(prop)

	Determines the maximum Feret diameter.


	Parameters

	prop (RegionProperties) – Describes a labeled region.



	Returns

	max_feret_diameter (float) – Maximum Feret diameter of the region.






See also


	skimage.measure.regionprops() [https://scikit-image.org/docs/stable/api/skimage.measure.html#skimage.measure.regionprops]
	Measure properties of labeled image regions







Examples

>>> import numpy as np
>>> from skimage.measure import regionprops
>>> image = np.ones((2,2), dtype=np.int8)
>>> prop = regionprops(image)[0]
>>> feret_diameter(prop)
2.23606797749979










	
grains.analysis.label_image_apply_mask(label_image, mask, value)

	Changes parts of a labeled image to a given value.

Convenience function, equivalent to label_image[mask] = value but the original array
label_image is not overwritten.


	Parameters

	
	label_image (ndarray) – Labeled input image, represented as a 2D numpy array of positive integers.


	mask (ndarray) – Boolean array of the same size as label_image, marking the pixels that will be
replaced by value.


	value (int) – The masked pixels are replaced by this value.






	Returns

	ndarray – Copy of the input image, its selected pixels being replaced by the given value.










	
grains.analysis.label_image_skeleton(label_image)

	Skeleton of a labeled image.

The skeleton of a labeled image is a single-pixel wide network that separates the labeled
regions.


	Parameters

	label_image (ndarray) – Labeled input image, represented as a 2D numpy array of positive integers.



	Returns

	ndarray – A 2D bool numpy array having the same size as label_image, where True represents
the skeleton pixels.






See also

thicken_skeleton()








	
grains.analysis.plot_grain_characteristic(characteristic, centers, interpolation='linear', grid_size=(100, 100), **kwargs)

	Plots the distribution of a given grain characteristic.

One way to gain insight into a grain assembly is to plot the distribution of a certain grain
property in the domain the grains occupy. In this function, for each grain, and arbitrary
(scalar) quantity is associated to the center of the grain. In case of n grains, n data
points span the interpolant and the given characteristic is interpolated on a grid of the
AABB of the grain centers.


	Parameters

	
	characteristic (ndarray) – Characteristic property, the distribution of which is sought. A 1D numpy array.


	centers (ndarray) – 2D numpy array with 2 columns, each row corresponding to a grain, and the two columns
giving the Cartesian coordinates of the grain center.


	interpolation ({‘nearest’, ‘linear’, ‘cubic’}, optional) – Type of the interpolation for creating the distribution. The default is ‘linear’.


	grid_size (tuple of int, optional) – 2-tuple, the size of the grid on which the data is interpolated. The default is (100, 100).






	Other Parameters

	
	center_marker (str, optional) – Marker indicating the center of the grains. The default is ‘P’. For a list of supported
markers, see the documentation [https://matplotlib.org/3.2.1/gallery/lines_bars_and_markers/marker_reference.html].
If you do not want the centers to be shown, choose ‘none’.


	show_axis (bool, optional) – If True, the axes are displayed. The default is False.






	Returns

	None






See also

scipy.interpolate.griddata() [https://docs.scipy.org/doc/scipy/reference/generated/scipy.interpolate.griddata.html#scipy.interpolate.griddata]



Notes

This function knows nothing about how the center of a grain is determined and what
characteristic features a grain has. It only performs interpolation and visualization,
hence decoupling the plotting from the actual representation of grains and their
characteristics. For instance, a grain can be represented as a spline surface, as a polygon,
as an assembly of primitives (often triangles), as pixels, just to mention some typical
scenarios. Calculating the center of a grain depends on the grain representation at hand.
Similarly, one can imagine various grain characteristics, such as area, diameter, Young modulus.

Examples

Assume that the grain centers are sampled from a uniformly random distribution on the unit
square.

>>> n_data = 100
>>> points = np.random.random((n_data, 2))





The quantity we want to plot has a parabolic distribution with respect to the position of the
grain centers.

>>> func = lambda x, y: 1 - (x-0.5)**2 - (y-0.5)**2
>>> plot_grain_characteristic(func(points[:, 0], points[:, 1]), points, center_marker='*')
>>> plt.show()










	
grains.analysis.plot_prop(prop, pixel_per_unit=1, show_axis=True)

	Plots relevant region properties into a single figure.
Four subfigures are created, giving the region’s



	image, its area and its center


	filled image, its area


	bounding box, its area


	convex image, its area








	Parameters

	
	prop (RegionProperties) – Describes a labeled region.


	pixel_per_unit (float or int, optional) – Number of pixels contained in a certain unit. The default is 1, in
which case all measurements are performed in pixel units.






	Returns

	fig (matplotlib.figure.Figure) – The figure object is returned in case further manipulations are necessary.










	
grains.analysis.show_label_image(label_image, alpha=1)

	Displays a labeled image.

A random color is associated with each labeled region. If boundary pixels are present in the
image, they are plotted in black.


	Parameters

	
	label_image (ndarray) – Labeled input image, represented as a 2D numpy array of non-negative integers.
The label 0 is assumed to denote a boundary pixel.


	alpha (float, optional) – Opacity of colorized labels. Must be within [0, 1].






	Returns

	None










	
grains.analysis.thicken_skeleton(skeleton, thickness)

	Thickens a skeleton by morphological dilation.


	Parameters

	
	skeleton (ndarray) – Skeleton of a binary image, represented as a bool 2D numpy array.


	thickness (int) – Thickness of the resulting boundaries.






	Returns

	ndarray – A 2D bool numpy array, where True represents the thickened skeleton.






See also

label_image_skeleton()








	
grains.analysis.truecolor2label(color_image)

	Truecolor image into labeled image.

It is often the case that you need to deal with a labeled image that was saved as a truecolor
image (e.g. RGB). A labeled region is then the set of pixels with the same colors.


	Parameters

	color_image (ndarray) – 3D array, the first two dimensions corresponding to the image pixels, the third one for
the channels (e.g. RGB, HSV, CMYK, etc.).



	Returns

	ndarray – Labeled image, represented as a 2D numpy array of non-negative integers.














Meshing


Classes







	SkeletonGeometry

	



	QuadSkeletonGeometry

	



	TriSkeletonGeometry

	



	FixedDict

	https://stackoverflow.com/a/14816446/4892892



	OOF2

	







	
class grains.meshing.FixedDict(dictionary)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

https://stackoverflow.com/a/14816446/4892892






	
class grains.meshing.OOF2

	Bases: object [https://docs.python.org/3/library/functions.html#object]


	
create_material(name)

	
	Parameters

	name (TYPE) – DESCRIPTION.



	Raises

	Exception [https://docs.python.org/3/library/exceptions.html#Exception] – DESCRIPTION.



	Returns

	None.










	
create_microstructure(name=None)

	Creates a microstructure from an image.


	Parameters

	name (str, optional) – Path to the image on which the microstucture is created,
file extension included. If not given, the microstructure is given
the same name as the input image.



	Raises

	Exception [https://docs.python.org/3/library/exceptions.html#Exception] – DESCRIPTION.



	Returns

	None.










	
create_skeleton(nelem_x, nelem_y, geometry, name=None)

	




	
load_pixelgroups(microstructure_file)

	
	Parameters

	microstructure_file (str) – DESCRIPTION.



	Returns

	None.










	
materials2groups(materials, groups=None)

	
	Parameters

	
	materials (list of str) – DESCRIPTION.


	groups (list of int, optional) – DESCRIPTION. The default is None.






	Returns

	None.










	
pixel2group()

	




	
read_image(label_image)

	




	
save_microstructure(name=None)

	




	
save_pixelgroups(name=None)

	
	Parameters

	name (str) – DESCRIPTION.



	Returns

	None.










	
script = []

	




	
show()

	
	Returns

	None.










	
write_script(name=None)

	








	
class grains.meshing.QuadSkeletonGeometry(leftright_periodicity=False, topbottom_periodicity=False)

	Bases: grains.meshing.SkeletonGeometry






	
class grains.meshing.SkeletonGeometry(leftright_periodicity, topbottom_periodicity)

	Bases: abc.ABC [https://docs.python.org/3/library/abc.html#abc.ABC]






	
class grains.meshing.TriSkeletonGeometry(leftright_periodicity=False, topbottom_periodicity=False, arrangement='conservative')

	Bases: grains.meshing.SkeletonGeometry






	
grains.meshing.nt

	alias of grains.meshing.modules










CAD




MED

Extracting and processing meshes from .med files.
The functions were tested on the MEDCoupling API, version 9.4.0.


Todo

Support renumbering (https://docs.salome-platform.org/latest/dev/MEDCoupling/user/html/data_optimization.html).



Getting help:


	This module relies on the Python interface of MEDCoupling. Click here [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/index.html] for the latest documentation.


	User’s manual [https://docs.salome-platform.org/latest/dev/MEDCoupling/user/html/index.html] for the Python interface


	To know more about the MED file format, which is a specialization of HDF5, see the documentation [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/med-file.html].
For a discussion on the relation between the MED format and the APIS, see this page [https://www.salome-platform.org/user-section/about/med] and that one [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/library.html].


	The definitions, such as group, used in this module are from the development guide [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/glossary.html].


	A (mostly English) tutorial [https://docs.salome-platform.org/latest/dev/MEDCoupling/tutorial/index.html] for the Python interface to MEDCoupling is also useful.
Particularly interesting are the mesh manipulation examples [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/medcouplingpyexamples.html#ExamplesMeshes]


	Main page [https://salome-platform.org/user-section/documentation/current-release] of the documentation





Functions







	read_mesh

	Reads a mesh file in .med format.



	get_nodes

	Obtains the nodes and the node groups of a mesh.



	get_elements

	Obtains the elements for each group of a mesh.







	
grains.med.get_elements(mesh, numbering='global')

	Obtains the elements for each group of a mesh.

Elements of the same dimension as the mesh are collected (e.g. faces for a 2D mesh).


Todo

put those elements that do not belong to any group into an automatically created group




Todo

support ordering elements in alphabetical order




Todo

implement the ‘global’ strategy




	Parameters

	
	mesh (MEDFileUMesh) – Unstructured mesh.


	numbering ({‘global’}, optional) –


	Determines how to allocate element numbers in the mesh.
	‘global’: numbers the elements without taking into account which group they belong to.
Use this strategy if you are not sure whether an element belongs to more than one group.
‘group’: numbers the elements group-wise. This is much faster than the ‘global’
strategy, but use this option if you are sure that the groups of the mesh do not
contain common elements.





The default is ‘global’.







	Returns

	
	elements (ndarray) – Element-node connectivities in a 2D numpy array, in which each row corresponds to an
element and the columns are the nodes of the elements. It is assumed that all the
elements have the same number of nodes.


	element_groups (dict) – The keys in the dictionary are the element group names, while the values are list of
integers, giving the elements that belong to the particular group.











Warning

Currently, elements that do not fit into any groups are discarded.




See also

get_nodes(), change_node_numbering()



Notes

The element-node connectivities are read from the mesh. If you want to change the ordering
of the nodes, use the change_node_numbering() function.

Both this and the get_nodes() function relies on getGroupsOnSpecifiedLev [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/classMEDCoupling_1_1MEDFileMesh.html#a2d59097b6d14b95c7d2aeee9f39b0438] to obtain the groups
based on a parameter, called meshDimRelToMaxExt. This parameter designates the relative
dimension of the mesh entities whose IDs are required. If it is 1, it denotes the nodes. If
0, entities of the same dimension as the mesh are meant (e.g. group of volumes for a 3D mesh,
or group of faces for a 2D mesh). When -1, entities of spatial dimension immediately below
that of the mesh are collected (e.g. group of faces for a 3D mesh, or group of edges for a
2D mesh). For -2, entities of two dimensions below that of the mesh are fetched (e.g. group of
edges for a 3D mesh).






	
grains.med.get_nodes(mesh)

	Obtains the nodes and the node groups of a mesh.


	Parameters

	mesh (MEDFileUMesh) – Unstructured mesh.



	Returns

	
	nodes (ndarray) – 2D numpy array with 2 columns, each row corresponding to a node, and the two columns
giving the Cartesian coordinates of the nodes.


	node_groups (dict) – The keys in the dictionary are the node group names, while the values are list of integers,
giving the nodes that belong to the particular group.











See also

get_elements(),
getGroupArr [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/classMEDCoupling_1_1MEDFileMesh.html#a4398c05f015e52d0d380eb39c6e4b942]








	
grains.med.read_mesh(filename)

	Reads a mesh file in .med format.
Only one mesh, the first one, is supported. However, that mesh can contain groups.


	Parameters

	filename (str) – Path to the mesh file.



	Returns

	MEDFileUMesh – Represents an unstructured mesh. For details, see the manual on
https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/classMEDCoupling_1_1MEDFileUMesh.html














Salome

The documentation generated from this file is available on
https://cristalx.readthedocs.io/en/latest/api.html#module-grains.salome.

The aim of this module is to manage geometry and mesh operations on
two-dimensional microstructures that tessellate a domain. This has the important consequence that
the domain is assumed to consist of non-overlapping shapes that cover it. After generating a
conforming mesh, each element belongs to a single group and no element exists outside the
group. More precisely, elements that do not belong to any group are not taken into account by the
Mesh class. They can still be accessed by the functions of Salome, but the use of such
lower-level abstractions is against the philosophy of encapsulation this module provides.

The non-goals of this module include everything not related to the tessellation nature of 2D
microstructures. The emphasis is on readability and not on speed.

This file can be used either as a module or as a script.


Using as a module

Developers, implementing new features, will use salome.py as a Python module. Although this
module is part of the grains package in the CristalX project [https://github.com/CsatiZoltan/CristalX], it does not rely on the other modules of
grains. This ensures that it can be used standalone and run as a script in the Salome environment. It only uses language constructs available in Python 3.6,
and external packages shipped with Salome 9.4.0 onwards. To enable debugging, code completion
and other useful development methods, consult with the documentation on …
Most classes contain a protected variable that holds the underlying Salome object. Unless you
debug, it is not necessary to directly deal with Salome objects programmatically.




Using as a script

When salome.py is run as a script, the contents in the if __name__ == "__main__": block
is executed. Edit it to suit your needs. Similarly to the case when used as a module, the script can only be run from Salome’s own Python interpreter: either from
the shell or from the GUI. To run it from the shell (including the GUI’s built-in Python command
prompt), type

exec(open("<path_to_CristalX>/grains/salome.py", "rb").read())





You can also execute the script from the GUI by clicking on File ‣ Load Script…




Classes







	Geometry

	Represents the geometrical entities of a two-dimensional tessellated domain.



	Face

	Closed part of a plane.



	Edge

	A shape corresponding to a curve, and bounded by a vertex at each extremity.



	Interface

	An edge between two faces.



	Mesh

	Performs mesh manipulations on a tessellated geometry.



	FaceMesh

	Mesh on a face, part of the whole mesh.



	InterfaceMesh

	Mesh on an interface, part of the whole mesh.



	CohesiveZone

	Constructs zero-thickness elements along the interfaces.



	GUI

	Using GUI-related functionalities in Salome.







	
class grains.salome.CohesiveZone(mesh)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Constructs zero-thickness elements along the interfaces.


	Parameters

	mesh (Mesh) – Mesh into which the cohesive elements will be inserted.






	
_affected_elements(interface_mesh)

	Face elements whose nodes must be renumbered when duplicating an interface mesh.


	Parameters

	interface_mesh (InterfaceMesh) – The original interface mesh that will be duplicated.



	Returns

	elements (set) – Elements of the mesh that require node renumbering.






See also

_enrich_interfaces()








	
_correct_junction_nodes()

	Post-processing to handle inconsistent interface nodes at the junctions.

The interface-wise creation of new edge elements in _affected_elements() may result
in edge element nodes that do not connect the opposite face element nodes on the two
sides of the interface. This function checks the edge element nodes at the junctions and
renumbers them so that they hold the same label as the face element nodes they connect to.


	Returns

	None.






See also

decouple_faces(), _affected_elements(), smeshBuilder.Mesh.FindCoincidentNodesOnPart() [https://docs.salome-platform.org/latest/gui/SMESH/smeshBuilder.html#smeshBuilder.Mesh.FindCoincidentNodesOnPart], smeshBuilder.Mesh.ChangeElemNodes() [https://docs.salome-platform.org/latest/gui/SMESH/smeshBuilder.html#smeshBuilder.Mesh.ChangeElemNodes]








	
_enrich_interfaces()

	Inserts new interface elements and nodes into the mesh.

Although Salome has built-in functionality for duplicating nodes and creating elements,
even accessible from the GUI with Modification -> Transformation -> Duplicate Nodes
and/or Elements, it does not work with multiple intersecting interfaces or for closed
interfaces. The reason is that the first step of the two-step procedure Salome performs
fails in such situations. Therefore, this method uses a modified algorithm for the first
step, and then calls the second step. These steps are the following:

1. Find the elements (called affected elements) in the mesh whose node numbers need to be
changed due to the topological changes in the mesh caused by the introduction of new nodes.

2. The affected elements are fed to an existing function in Salome, which returns the 1D
elements it creates from the duplicated nodes. The new interface mesh is stored in the
CohesiveZone object.


	Returns

	None.






See also

decouple_faces(), _affected_elements(), smeshBuilder.Mesh.DoubleNodeElemGroups() [https://docs.salome-platform.org/latest/gui/SMESH/smeshBuilder.html#smeshBuilder.Mesh.DoubleNodeElemGroups], smeshBuilder.Mesh.MakeGroupByIds() [https://docs.salome-platform.org/latest/gui/SMESH/smeshBuilder.html#smeshBuilder.Mesh.MakeGroupByIds]








	
_generate_cohesive_element(bottom_element, top_element)

	Creates a zero-thickness quadrilateral element.


	Parameters

	
	bottom_element (int) – Edge element that will form the bottom edge of the cohesive element.


	top_element (int) – Edge element that will form the top edge of the cohesive element. It is assumed that
the top element geometrically overlaps with the bottom element.






	Returns

	list of int – The four nodes of the cohesive element, numbered counter-clockwise. The node
ordering adheres to the node numbering in Abaqus [https://abaqus-docs.mit.edu/2017/English/SIMACAEELMRefMap/simaelm-r-cohesive2d.htm#simaelm-r-cohesive2d-t-nodedef1].






See also

Mesh.incident_elements(), Mesh.element_edge_normal(), smeshBuilder.Mesh.GetElemNodes() [https://docs.salome-platform.org/latest/gui/SMESH/smeshBuilder.html#smeshBuilder.Mesh.GetElemNodes], smeshBuilder.Mesh.GetNodeXYZ() [https://docs.salome-platform.org/latest/gui/SMESH/smeshBuilder.html#smeshBuilder.Mesh.GetNodeXYZ]








	
create_cohesive_elements()

	Creates zero-thickness quadrilateral elements along the interfaces.

It is necessary that the mesh has already been decoupled along the interfaces by the
decouple_faces() method. That method introduced duplicated nodes and edge elements
along the interfaces. The purpose of this method is to tie each interface (edge) element
to its corresponding duplicate in order to form a four-noded zero-thickness element,
referred to as cohesive element. The bottom edge of the new cohesive element corresponds
to the original edge element, while its top edge is formed by the duplicated interface
edge element.


	Returns

	cohesive_elements (list) – List of nodes that form the cohesive elements. The node numbering follows the
node ordering of Salome [https://docs.salome-platform.org/latest/gui/SMESH/connectivity.html#connectivity-page], which is the same as the node ordering in
Abaqus [https://abaqus-docs.mit.edu/2017/English/SIMACAEELMRefMap/simaelm-r-cohesive2d.htm#simaelm-r-cohesive2d-t-nodedef1].






See also

decouple_faces(), _generate_cohesive_element(), smeshBuilder.Mesh.AddFace() [https://docs.salome-platform.org/latest/gui/SMESH/smeshBuilder.html#smeshBuilder.Mesh.AddFace]








	
decouple_faces()

	Decouples the face meshes along the interfaces.

The algorithm consists of two main steps. First, new interface meshes are created that
overlap with the existing ones and contain independent nodes and interface elements. In
the same step, the incident face mesh nodes are updated to reflect the topological
changes. However, in this method, extra nodes are introduced at the junctions,
leading to a kinematic inconsistency. Therefore, the extraneous interface mesh nodes are
renumbered in the second step of the algorithm.


	Returns

	None.






See also

create_cohesive_elements()












	
class grains.salome.Edge(edge, name)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

A shape corresponding to a curve, and bounded by a vertex at each extremity.

An Edge knows about the Face it is part of, and the faces neighboring it.


	Parameters

	
	edge (GEOM_Object of shape type ‘EDGE’) – The main Salome object wrapped by this class.


	name (str) – Name of the edge.









See also

GEOM_Object [https://docs.salome-platform.org/latest/gui/GEOM/geompy_doc/interfaceGEOM_1_1GEOM__Object.html],
Shape type [https://docs.salome-platform.org/latest/gui/GEOM/geompy_doc/namespaceGEOM.html#a82a00e336c65dad4cc04b65563b26eb5]




	
length()

	Length of the edge.


	Returns

	float – Length of the edge.






See also

geomBuilder.BasicProperties [https://docs.salome-platform.org/latest/gui/GEOM/geompy_doc/group__l2__measure.html#ga6d60abd33031977af29b8036d001bf8b]












	
class grains.salome.Face(face, name)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Closed part of a plane.

A Face knows about the Edge objects that bound it.


	Parameters

	
	face (GEOM_Object of shape type ‘FACE’) – The main Salome object wrapped by this class.


	name (str) – Name of the face.









See also

GEOM_Object [https://docs.salome-platform.org/latest/gui/GEOM/geompy_doc/interfaceGEOM_1_1GEOM__Object.html],
Shape type [https://docs.salome-platform.org/latest/gui/GEOM/geompy_doc/namespaceGEOM.html#a82a00e336c65dad4cc04b65563b26eb5]








	
class grains.salome.FaceMesh(face_mesh, name, on_face)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Mesh on a face, part of the whole mesh.


	Parameters

	
	face_mesh (smeshBuilder.Mesh.GroupOnGeom) – The main Salome object wrapped by this class.


	name (str) – Name of the face mesh.


	on_face (Face) – Geometrical face on which this mesh exists.









	
elements()

	Retrieves the elements of the face mesh.


	Returns

	list of int – Elements belonging to the face mesh.






See also

SMESH.SMESH_IDSource.GetIDs() [https://docs.salome-platform.org/latest/gui/SMESH/smesh_module.html#SMESH.SMESH_IDSource.GetIDs]








	
nodes()

	Retrieves the nodes of the face mesh.


	Returns

	list of int – Nodes belonging to the face mesh.






See also

SMESH.SMESH_GroupBase.GetNodeIDs() [https://docs.salome-platform.org/latest/gui/SMESH/smesh_module.html#SMESH.SMESH_GroupBase.GetNodeIDs]












	
class grains.salome.GUI

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Using GUI-related functionalities in Salome.

Notes

A part of Salome’s GUI is exposed to Python. To get an idea of what is available, see
https://docs.salome-platform.org/latest/gui/GUI/text_user_interface.html


	
exception SalomeNoDesktop

	Bases: Exception [https://docs.python.org/3/library/exceptions.html#Exception]

Raised when Salome is run without desktop, but a desktop functionality is invoked.






	
classmethod _get_component(obj)

	Determines the component of an object.

This function maps a class of this module to the Salome module the class uses. For instance,
class Face is mapped to ‘GEOM’.


	Parameters

	obj – Any object for which the component name is looked for.



	Returns

	str or None – The name of the component the object belongs to. If an object of an unsupported class
is given, None is returned. For the list of supported classes, see the
component_map member of GUI class.






See also

show()








	
static assert_salome_desktop()

	Checks if Salome’s GUI is available, and raises an exception if it is not.

This function acts as a helper function when relying on Salome’s GUI.


	Raises

	SalomeNoDesktop – If Salome’s GUI is not available.










	
component_map = {<class 'grains.salome.Geometry'>: 'GEOM', <class 'grains.salome.Face'>: 'GEOM', <class 'grains.salome.Edge'>: 'GEOM', <class 'grains.salome.Interface'>: 'GEOM', <class 'grains.salome.Mesh'>: 'SMESH', <class 'grains.salome.FaceMesh'>: 'SMESH', <class 'grains.salome.InterfaceMesh'>: 'SMESH'}

	




	
static has_desktop()

	Indicates if the Salome GUI is running.


	Returns

	bool – True if Salome’s GUI is available, False otherwise.










	
classmethod show(obj, show_only=False)

	Shows objects in Salome’s GUI.


Todo

Support list of objects.




	Parameters

	
	obj (iterable) – The object(s) to be shown in Salome. Objects of the following classes are supported:
Geometry, Face, Edge, Interface, Mesh, FaceMesh, InterfaceMesh.


	show_only (bool, optional) – If True, the other objects are hidden. The default value is False.






	Returns

	None



	Raises

	
	SalomeNoDesktop – If Salome’s GUI is not available.


	TypeError [https://docs.python.org/3/library/exceptions.html#TypeError] – If obj is not an object that can be displayed.


	ValueError [https://docs.python.org/3/library/exceptions.html#ValueError] – If the given object does not exist in the Salome study.








Examples

For example, you can display an interface mesh and a face mesh by calling

GUI.show([interface_mesh, face_mesh])





where interface_mesh and face_mesh are InterfaceMesh and
FaceMesh objects respectively. This way of using the show method provides
great flexibility as different types of objects can be handled at the same time.






	
static update_object_browser()

	Refreshes Salome’s object browser.

Only makes sense if executed with the GUI enabled.


	Returns

	None






See also

has_desktop()








	
classmethod view(view='top')

	Sets the viewpoint.


	Parameters

	view ({‘front’, ‘back’, ‘top’, ‘bottom’, ‘left’, ‘right’}, optional) – Position from which the scene is viewed. The default is ‘top’.



	Returns

	None














	
class grains.salome.Geometry(name='microstructure')

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Represents the geometrical entities of a two-dimensional tessellated domain.

A Geometry object knows about the faces that tessellate the domain, and about the
edges and interfaces that separate the faces.


	Parameters

	name (str, optional) – Name of the geometry.






See also

Face, Edge, Interface




	
_find_overlapping_edges()

	Finds edges that are on top of each other.

Overlapping edges have the same length. Although its converse is not true in general,
we will assume so. This part of the algorithm (i.e. deciding the overlapping edges) can
later be refined.


	Returns

	overlapping_edges (list) – Each member of the list contains a list of (supposedly) two Edge objects.






See also

create_interfaces(), Edge.length()








	
static _has_smaller_ID(edges)

	Selects the edge with a smaller ID.

When generating mesh with the NETGEN plugin of Salome, if several edges overlap, only the
edge with the smallest ID holds a mesh. The purpose of this function is to find the edge
with the smaller ID out of two overlapping edges.


	Parameters

	edges (list of Edge) – List of two Edge objects.



	Returns

	Edge – Either the first or the second element of the input list, depending on which of them
has a smaller ID.






See also

create_interfaces()



Notes

For a detailed discussion on this highly important issue, see the
corresponding forum thread [https://www.salome-platform.org/forum/forum_11/79066443].






	
create_interfaces()

	Constructs unique interfaces that separate the faces.

Based on the edges (obtained by exploding the mesh), interfaces are created.
Interfaces are unique separators of two neighboring faces. In other words,


	if the edge is a boundary edge, no interface is created,


	two neighboring faces have two overlapping edges, of which one is defined
to be an interface.




It is assumed that the edges and faces of the geometry have already been obtained.


	Returns

	None.






See also

extract_faces(), extract_edges()








	
extract_edges()

	Decomposes each face into edges.

This method must be called after the extract_faces() method, otherwise it
has no effect.


	Returns

	None.






See also

extract_faces()








	
extract_faces()

	Decomposes the geometry into faces.


	Returns

	None.






See also

extract_edges()








	
load(step_file)

	Loads the geometry from a STEP file.


	Parameters

	step_file (str) – The STEP file containing the geometry.



	Returns

	None.














	
class grains.salome.Interface(edge, name, neighboring_faces)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

An edge between two faces.

Similar to an Edge, but two neighboring Face objects share a common
Interface. An Interface knows about the two faces that it separates.


	Parameters

	
	edge (GEOM_Object of shape type ‘EDGE’) – The main Salome object wrapped by this class.


	name (str) – Name of the interface.


	neighboring_faces (list of Face) – The two neighboring faces.









See also

Edge, Face




	
length()

	Length of the interface.


	Returns

	float – Length of the interface.






See also

geomBuilder.BasicProperties [https://docs.salome-platform.org/latest/gui/GEOM/geompy_doc/group__l2__measure.html#ga6d60abd33031977af29b8036d001bf8b]












	
class grains.salome.InterfaceMesh(interface_mesh, name, on_interface)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Mesh on an interface, part of the whole mesh.


	Parameters

	
	interface_mesh (smeshBuilder.Mesh.GroupOnGeom) – The main Salome object wrapped by this class.


	name (str) – Name of the interface mesh.


	on_interface (Interface) – Interface on which this mesh exists.









	
elements()

	Retrieves the elements of the interface mesh.


	Returns

	list of int – Elements belonging to the interface mesh.






See also

SMESH.SMESH_IDSource.GetIDs() [https://docs.salome-platform.org/latest/gui/SMESH/smesh_module.html#SMESH.SMESH_IDSource.GetIDs]








	
elements_by_nodes(nodes)

	Connecting elements to given nodes.


	Parameters

	nodes (list of int) – Nodes for which we want to find the connecting elements.



	Returns

	list of int – Elements that are incident to the given nodes.






See also

smeshBuilder.Mesh.GetElementsByNodes() [https://docs.salome-platform.org/latest/gui/SMESH/smeshBuilder.html#smeshBuilder.Mesh.GetElementsByNodes]








	
endpoint_nodes()

	Nodes at the extremities of the interface mesh.


	Returns

	ep_nodes (list of int) – Nodes of the end points of the interface on which the interface mesh is defined. If
the interface is open, it has two end points. When closed, the two end points
coincide and instead of the two coinciding nodes, a single node is returned.










	
nodes()

	Retrieves the nodes of the interface mesh.


	Returns

	list of int – Nodes belonging to the interface mesh.






See also

SMESH.SMESH_GroupBase.GetNodeIDs() [https://docs.salome-platform.org/latest/gui/SMESH/smesh_module.html#SMESH.SMESH_GroupBase.GetNodeIDs]












	
class grains.salome.Mesh(geometry, name='Mesh')

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Performs mesh manipulations on a tessellated geometry.


	Parameters

	
	geometry (Geometry) – Geometry object on which the mesh exists.


	name (str, optional) – Name of the mesh.









See also

Geometry, FaceMesh, InterfaceMesh




	
class ElementType

	Bases: enum.Enum [https://docs.python.org/3/library/enum.html#enum.Enum]

Subset of the element types recognized by Salome.

This enumeration is for convenience. Only those elements of Salome are considered that
are relevant for the Mesh class.


See also

SMESH.ElementType [https://docs.salome-platform.org/latest/gui/SMESH/smesh_module.html#SMESH.ElementType]




	
ALL

	




	
EDGE

	




	
FACE

	




	
NODE

	








	
element_edge_normal(element, edge)

	Outward-pointing unit normal to an element edge.

The edge is assumed to be planar.


	Parameters

	
	element (int) – ID of the element.


	edge (list of int) – Edge of the element for which the normal is to be found. The edge is given by its
two nodes.






	Returns

	normal (tuple of float) – Outward-pointing unit normal.






See also

point_in_element()








	
generate()

	Generates a mesh on the geometry.


Todo

Do not hardcode values and explain the need for consistent orientation.








	
generate_element_nodes(elements)

	Nodes of selected elements, returned one at a time.


	Parameters

	elements (iterable) – Element IDs.



	Yields

	list of int – The first entry of the list is the element ID, the remaining entries are the node IDs
of the element.










	
incident_elements(edge, element_type=None)

	Searches for elements incident to an edge.


	Parameters

	
	edge (list of int) – An edge of an element, given by its two nodes.


	element_type (Mesh.ElementType, optional) – Perform the search for the given element type only.






	Returns

	list of int – Element IDs that are incident to the given edge.






See also

smeshBuilder.Mesh.GetNodeInverseElements() [https://docs.salome-platform.org/latest/gui/SMESH/smeshBuilder.html#smeshBuilder.Mesh.GetNodeInverseElements]








	
incident_face_mesh(interface_mesh)

	Face meshes incident to an interface mesh.


Todo

Use this method in _affected_elements as well.




	Parameters

	interface_mesh (InterfaceMesh) – Interface mesh for which the connecting face meshes are sought.



	Returns

	face_mesh (list of FaceMesh) – Face meshes incident to an interface mesh.



	Raises

	Exception [https://docs.python.org/3/library/exceptions.html#Exception] – If no face mesh is incident to the interface mesh.










	
obtain_face_meshes()

	Retrieves the elements of the mesh on each face.


	Returns

	None.










	
obtain_interface_meshes()

	Obtains the 1D interfacial mesh for each interface.


	Returns

	None.










	
one_ring(node, definition='connecting')

	Elements around a node.


	Parameters

	
	node (int) – Node ID for which the one-ring is searched.


	definition ({‘connecting’, ‘surrounding’}, optional) – What you mean by neighboring elements. See the notes below.






	Returns

	list – List of integers (element IDs).





Notes

One should make a distinction between elements connecting to a node and elements
surrounding a node. For a mesh with no overlapping nodes, the two definitions give the
same elements. However, if multiple nodes are located at the same geometrical point, it can
happen that the incident elements are not connected to the same node.






	
point_in_element(element, point)

	Checks whether a point is in an element.

This method is implemented for 2D meshes only.


	Parameters

	
	element (int) – Element of the mesh.


	point (tuple of float) – Point coordinates (x,y).






	Returns

	bool – True if the given element contains the given point.



	Raises

	
	Exception [https://docs.python.org/3/library/exceptions.html#Exception] – If the mesh is not two-dimensional.


	ValueError [https://docs.python.org/3/library/exceptions.html#ValueError] – If the element does not exist in the mesh.








Notes

This method calls an efficient matplotlib function to determine whether a point is in
a polygon. For alternative implementations, see this discussion [https://stackoverflow.com/questions/36399381/whats-the-fastest-way-of-checking-if-a-point-is-inside-a-polygon-in-python].


See also

matplotlib.path.Path.contains_point() [https://matplotlib.org/stable/api/path_api.html#matplotlib.path.Path.contains_point]
















Geometry

This module implements computational geometry algorithms, needed for other modules.

All the examples assume that the modules numpy and matplotlib.pyplot were imported as np
and plt, respectively.


Classes







	Mesh

	Data structure for a general mesh.



	TriMesh

	Unstructured triangular mesh.



	Polygon

	Represents a polygon.









Functions







	is_collinear(points[, tol])

	Decides whether a set of points is collinear.



	squared_distance(x, y)

	Squared Euclidean distance between two points.



	distance_matrix(points)

	A symmetric square matrix, containing the pairwise squared Euclidean distances among points.



	_polygon_area(x, y)

	Computes the signed area of a non-self-intersecting, possibly concave, polygon.







	
class grains.geometry.Mesh(vertices, cells)

	Bases: abc.ABC [https://docs.python.org/3/library/abc.html#abc.ABC]

Data structure for a general mesh.

This class by no means wants to provide intricate functionalities and does not strive to be
efficient at all. Its purpose is to give some useful features the project relies on.
The two main entities in the mesh are the vertices and the cells. They are expected to be
passed by the user, so reading from various mesh files is not implemented. This keeps the
class simple, requires few package dependencies and keeps the class focused as there are
powerful tools to convert among mesh formats (see e.g. meshio [https://github.com/nschloe/meshio]).


	Parameters

	
	vertices (ndarray) – 2D numpy array with 2 columns, each row corresponding to a vertex, and the two columns
giving the Cartesian coordinates of the vertex.


	cells (ndarray) – Cell-vertex connectivities in a 2D numpy array, in which each row corresponds to a
cell and the columns are the vertices of the cells. It is assumed that all the cells
have the same number of vertices.









See also

change_vertex_numbering



Notes

Although not necessary, it is highly recommended that the local vertex numbering in the
cells are the same, either clockwise or counter-clockwise. Some methods, such as
get_boundary() even requires it. If you are not sure whether the cells you provide
have a consistent numbering, it is better to renumber them by calling the
change_vertex_numbering() method.


	
static _ismatrix(array)

	Decides whether the input is a matrix.


	Parameters

	array (ndarray) – Numpy array to be checked.



	Returns

	bool – True if the input is a 2D array. Otherwise, False.






See also

_isvector()








	
static _isvector(array)

	Decides whether the input is a vector.


	Parameters

	array (ndarray) – Numpy array to be checked.



	Returns

	bool – True if the input is a 1D array or if it is a column or row vector. Otherwise, False.






See also

_ismatrix()








	
associate_field(vertex_values, name='field')

	Associates a scalar, vector or tensor field to the nodes.

Only one field can be present at a time. If you want to use a new field, call this method
again with the new field values, which will replace the previous ones.


	Parameters

	
	vertex_values (ndarray) – Field values at the nodes.


	name (str, optional) – Name of the field. If not given, it will be ‘field’.






	Returns

	